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Preface 
   

Overview This document provides detailed instructions for using the features of the Advanced 
SSR Scheduling Tool (ASSET).  The NASA Goddard Space Flight Center's (GSFC) 
Mission Applications Branch (Code 583) developed ASSET for the Terra Flight 
Operations Team. ASSET is a software tool for partially automating the scheduling 
of playbacks for the SSR buffers on Terra. 
  

Audience This guide is intended for users of the ASSET tool needing direction scheduling SSR 
buffer playbacks for Terra with ASSET. 
   

Applicability The information in this document corresponds to ASSET Release 4.0. 
 

For more 
information: 

Copies of this document, along with questions or proposed changes, should be 
addressed to: 
 

Patricia Johnson 
Mission Applications Branch 
Code 583 
Goddard Space Flight Center 
Greenbelt, Maryland 20771 
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1.1 What is ASSET? 

Why Was 
ASSET 
Developed? 

The Advanced SSR Scheduling Tool (ASSET) is a software package for partially 
automating the process of scheduling playbacks for Solid State Recorder (SSR) 
buffers on the Terra satellite during non-standard events and difficult planning 
periods. Limitations in the current scheduling system, the Mission Management 
System (MMS), preclude its use for scheduling SSR playbacks for non-standard 
events and difficult planning periods such as Inclination adjustments and loss of 
TDRS contact time. Developed to support the Terra Flight Operations Team 
(FOT), ASSET automates the parsing of input reports, extraction of events from 
the files and generation of playback schedules.  

Previously, this process involved using manual procedures supported by a 
collection of commercial off-the-shelf tools (COTS) such as Microsoft Excel.  

ASSET 
Functionality 

In addition to partially automating the manually intensive task of scheduling 
playbacks for non-standard events and difficult planning periods, ASSET 
provides the following functions:  

! Automated parsing of required reports files. This includes the TDRS contact 
report, the ATC load report, the SSR buffer dump report, the Orbital events 
report, and the ground contact report. 

! Extraction of events from the report files. Extracted events include NADIR 
Term crossing to Day/Night events, K, S and X band contacts, and ASTER 
imaging modes. 

! Automatic and manual creation of dump windows within X and K band 
contacts. 

! SSR Buffer Dump Schedule generation and playback determination. 

Other functionality provided by ASSET includes: 

• The ability to filter the displayed and printed data. 

• Customization of the ASSET interface. 

• The ability to save generated schedules and use them as baselines for future 
schedules.  
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1.2 System Requirements 

Overview The ASSET application is a cross-platform tool, written in Java.  The following 
table describes the minimum system requirements for using ASSET. 

  

The system requirements for using ASSET are as follows: 
  

 Required Recommended 

OS Windows 98, NT, 2000 or 
ME.  In addition ASSET 
should run on any operating 
system that supports Java 2 
(JRE 1.4). However ASSET 
has only been tested on the 
Windows platform 

Windows NT or 2000.  In 
addition ASSET should run 
on any operating system 
that supports Java 2 (JRE 
1.4). However ASSET has 
only been tested on the 
Windows platform 

Memory 128 MB RAM 256 MB RAM 

Processor Pentium II class or faster 
processor 

Pentium III 500 MHz or 
faster processor 

Disk Space 45 MB (additional space 
may be required to store 
saved schedules) 

100 MB (additional space 
may be required to store 
saved schedules) 

Video 800 x 600  1024 x 768 

Minimum 
Specifications: 

Other CD Rom Drive  CD Rom Drive 

Note: Future versions of ASSET will be tested on the Unix platform. 
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1.3 Using this Manual 
  

Organization of 
this Manual 

This manual describes the operations one can perform using ASSET and how to use 
the different features of the tool.  The manual is organized as follows: 

! Section 1 of this document provides introductory material. 

! Section 2 provides basic instructions for getting started with ASSET. 

! Section 3 provides instructions for working with schedules. 

! Section 4 provides instructions for filtering the data displayed and printed. 

! Section 5 provides miscellaneous information about ASSET and its use. 
 

Conventions 
 The following terms and notational conventions are used in this document:  

  Indicates a procedure, directing the user on how to 
perform a particular action. 

 

 Note: Indicates a note, providing information that may be 
helpful to the user. 

 

  Indicates a Warning, Caution, or other important 
information that users should know. 

 

 bold serif type Indicates menu items, buttons or check boxes that 
perform some action when selected with the mouse.  

Can also indicate window and field titles. 

 

 Italics For menu selections may also be performed using a 
combination of keystrokes, the keystrokes are listed in 
italics (e.g. Ctrl+A). 

 

 “Italics” Indicates system messages displayed to the user.  

 Items in CAPS Indicates a specific key on the keyboard (e.g. TAB or 
ENTER). 
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2.1 Installing ASSET 
  

Before You 
Begin: 

To install ASSET, your computer must have a CD-ROM drive, or you must have 
access to the ASSET installation zip file on separate media (generally a ZIP disk).  
We recommend installing from CD-ROM if possible.  Please refer to Section 1.2, 
System Requirements, to verify that your system meets the minimum requirements 
for ASSET. 
 

 Installing ASSET from CD-ROM: 

1.  Insert the ASSET CD in the CD-ROM drive.   

2.  Create a folder on your computer for the ASSET distribution. 

3.  Copy the contents of the “Asset” folder on the CD-ROM into the folder 
you created in step 2. 

4.  ASSET is now installed on your computer. 

 

 Installing ASSET from CD-ROM using the graphical installer: 

1.  Insert the ASSET CD in the CD-ROM drive.   

2.  Double click on the installation file: “install_ASSET.exe”. 

3.  Follow the directions in the wizard to install the software. Figure 
2.1.1 shows a picture of the installation wizard. You will need to 
provide the following information: 

a. The location on your computer where you want to install ASSET 

b. The location on your computer where you want to install the 
shortcut to ASSET. Note that the installer will provide a default 
location. 

4.  After you have provided all necessary information, the Installer 
installs ASSET on your computer in the specified location.  When the 
installation is complete, click the Finished button and ASSET is 
now installed on your computer. 
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Figure 2.1.1 
 The ASSET 
Installation 

Screen 
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2.2 Starting and Quitting ASSET 
  

Before You 
Begin 

ASSET should be properly installed on your computer.   

  

 To Start ASSET on a Windows machine: 

1.  Open the folder in which you installed ASSET. 

2.  Double click on the “Start ASSET.bat” file. 

3.  Or double click on the desktop shortcut for ASSET. 

 

 To Start ASSET on a Windows machine (if you installed using the graphical 
installer): 

1.  Click the Windows Start button. 

2.  Select Programs. 

3.  Select ASSET. 

4.  Click on the ASSET button. 

  

Note:  A “splash screen” (see Figure 2.2.1) is displayed while the system loads.   After 
loading, the ASSET Main Window is displayed (see Figure 2.2.2). 
  

Figure 2.2.1 
 The ASSET 

Splash Screen 
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Figure 2.2.2 
 The ASSET Main 

Window 

 
  

 To Quit ASSET: 

Pull down the File menu and choose Exit. Or use the ALT + X keyboard 
shortcut, or click the close box in the upper right hand corner of the main 
window. Selecting any of these options causes the application to shut down.



2. Getting Started 
 

 14

2.3 ASSET Windows  
 

Overview The ASSET interface is composed of a single main application window.  Within 
the main application window is a timeline that displays schedule information 
such as contact periods, dump windows, playback windows etc. Additionally, the 
main window provides a menu bar for controlling system operation and a tool bar 
containing frequently used features of ASSET. 
  

ASSET 
Windows  

The following are a few of the many windows (dialogs) in ASSET. Other windows are 
introduced later in this document to describe different functionality. 

   

Title Window Description 

Main 
Window 

 

This is the main 
application window 
presented to the user at 
program start-up. 
Through this window, 
the operator controls the 
ASSET tool. 

Timeline 

 

The main application 
window showing an 
empty timeline. 
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Timeline 

 

The main application 
window showing a 
timeline containing 
several events. 

Scheduling 
Options  

 

The scheduling options 
window is used to specify 
required scheduling 
value such as the 
scheduling horizon, 
report location, modeling 
modes, etc 

Preferences 

 

The options in the 
preferences window are 
used to customize the 
appearance of the 
ASSET user interface. 
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2.4 ASSET Toolbar 
 

Overview 
The ASSET main window contains a toolbar of buttons. The buttons provides quick 
access to often-used functions of ASSET. This section describes the toolbar and the 
features it provide. 

 

Main Window 
Toolbar 

The main ASSET window contains a selection of commonly used features in a 
toolbar.  This toolbar is always available, although certain tools (options) may be 
disabled based on the context (e.g., the create contacts tool will be unavailable if 
scheduling options have not been specified).  The following operations are available 
on the toolbar: 

 
Tool Function 

 New Schedule:   Creates a new playback schedule. Existing 
schedules are closed (saved or not based on user 
selection) before the new schedule is created. 

 Open Schedule: Opens a previously saved schedule. Existing 
schedules are closed (saved or not based on user 
selection) before the schedule is opened. 

 Save Schedule: Saves the current schedule in binary or text 
format. 

 Save Schedule As: Saves the current schedule with a different 
type. Also allows schedule to be saved as text.  

 Print Schedule: Sends the current schedule to a printer. 

 Scheduling Options: Pops up the scheduling options dialog for 
specifying the scheduling options needed by 
ASSET. 

 Create Contacts: Parses the reports files and extract events 
from the files and displays them on the timeline. 

 Select Sync Point: Displays the synchronization point selection 
dialog. 

 Generate Schedule: Generates and displays an SSR playback 
schedule. 
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2.5 ASSET Menu 
 

Overview 
The ASSET main window contains a single menu for accessing all ASSET 
functionality.  This section details the functionality provided by the menu bar and 
how to access the operations. 

 
Menu Item Function 

File> The File menu handles most file management tasks for ASSET.  
Items contained in this menu include:  

  Creating a New schedule.  

  Opening a saved schedule. 

  Saving a schedule (both in binary and text formats).  

  Closing a schedule. 

  Specifying scheduling options. Creating contacts. 

  Selecting a synchronization point. 

  Generating a schedule. 

  Exiting the system. 

Settings> This menu contains features for customizing ASSET. Items 
contained in this menu include:  

  Selecting display and print filters 

  Setting column widths both for the timeline and printed schedule

  Editing ASTER modeling rates 

  Setting Red and Yellow Limits 

  Setting user preferences 

  Setting MMS connection information 

  Managing Stations 

  Configuring offsets for automatic dump windows creation 

Help> This menu provides access to Tip of the Day and ASSET online 
help. 
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3 Working with Schedules 
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3.1 Creating a New Schedule 
  

Overview Playback Schedules are the products of ASSET. A playback schedule consists of a 
synchronization point, contact periods, rate change events, (such as MODIS DAY 
and MODIS NIGHT) dump windows and playback periods.  
  

 To create a new schedule: 

1.  Pull down the File menu and choose New OR 

Click on the New Schedule icon on the toolbar.  

2.  The system empties the internal schedule, clears the list of events 
and contacts, and clears the timeline. 

3.  If an unsaved schedule is currently open in the application, ASSET 
prompts the user to save the file.  

  Select Yes to save the old schedule. (Note that you will be 
prompted for a file name and location) 

  Select No to discard the current schedule without saving.  

  Select Cancel to retain the current schedule. 

4.  Figure 3.1.1 shows the main window after creating a new schedule. 

 

Figure 3.1.1:  
ASSET window 
showing a new 
schedule 
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3.2 Scheduling Options 
 

Overview After creating a new schedule, the next step in generating a playback schedule is to 
specify the scheduling options to be used for schedule generation. This includes 
specifying the plan start and stop times, ASTER modeling mode and percentage, and 
the location of report files. 

Note: For ASSET version 3.0 and lower, report files must be located on the same computer 
as ASSET or on a network location accessible from the computer on which ASSET is 
installed.  Future release of ASSET will include the functionality to retrieve the 
reports directly from MMS. 
  

 To open the scheduling options window: 

 Pull down the File menu and choose Scheduling Options…  OR

 Click on the Scheduling Options icon on the toolbar.   . 

Figure 3.2.1 shows the scheduling options window. 
  

 The scheduling options windows contains the following user specified fields: 

Plan Start This is the start date/time for the special event schedule. 
Format is: yyyy/doy/hh:mm:ss. 

Plan Stop This is the plan stop date/time.  During parsing of report 
files, events that occur after the plan stop time are 
ignored. The plan start and stop time are used to limit 
the events parsed from report files. Format is: 
yyyy/doy/hh:mm:ss. 

Create Partial 
Playbacks 

This value controls whether ASSET will attempt to 
create partial playbacks for dump windows that need 
them. See Section 5.2: Dump Windows for more 
information about partial playbacks. 

Max Sync Point 
Offset 

This value is used in conjunction with the plan start 
time. In the window of time specified by the different 
between the plan start time and the plan start time 
minus the sync point offset, ASSET searches for 
candidate synchronization points (i.e. contact periods 
where all buffers of the SSR can be completely emptied). 
Format is: hh:mm. 

Aster Modeling 
Mode 

A flag indicating how ASSET will model the ASTER 
Buffer. Selecting “Manual” (the default option) instructs 
ASSET to use a fixed percentage to modeling ASTER 
usage. Selecting “Automatic” instructs SPLAY to model 
ASTER usage based on actual ASTER usage as specified 
in the ATC load report. Note that when “Automatic” is 
selected, an ATC load report must be specified during 
report selection.  
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Aster Modeling % A fixed percentage value. Used for modeling the ASTER 
buffer usage in “Manual” mode. This field is not required 
if Aster Modeling Mode is set to "Automatic".  

Reports Location A drop down box indicating the location of the required 
input reports. The default option, "Local Directory", 
indicates that reports are on the local computer on 
which ASSET is running or on a network accessible 
drive. The other option "MMS" instructs ASSET to 
retrieve the reports directly from MMS. See Section 
5.11: MMS Interface for more information. 

 

Figure 3.2.1:  The 
Scheduling 
Options Window 

  

Note:  Starting with release 4.0 of ASSET, report files can be automatically downloaded 
from MMS. See Section 5.11: MMS Interface for more information.  
  

 

To Select the reports used during schedule generation, the user must click the 
Select Reports… button on the scheduling options window. Selecting this 
option when using local reports causes ASSET to display the Report Files 
window (Figure 3.2.2). If the Select Reports… button is clicked while Reports 
Location: is set to “MMS”, ASSET will attempt to download report files directly 
from MMS.  

 

Within the reports window, the operator specifies the name and location of the 
input reports. The input reports window contains the following fields: 

ATC Load Report The ATC load report contains the ASTER RTCS IDs. 
When specified, ASSET parses the valid IDs and adds 
the events to the timeline. For a list of the default RTCS 
IDs, how to add more IDs, and how to delete unwanted 
IDs, see Section 5.5: ASTER RTCS Identifiers. Note that 
this report is required, and visible only when Aster 
Modeling Mode is set to "ATC".  In addition this report 
cannot be automatically downloaded from MMS. It must 
be manually retrieved and placed on the user’s local 
computer. 
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TDRS Report This report contains K-band and S-band TDRS contact 
periods.  

SSR Buffer States This report contains buffer states entries for use in sync 
point determination.  

Orbital Events This report contains NADIR_TERM_CROSSING events 
used to determine MODIS and MISR DAY/NIGHT.  

GN Report This report contains X-band or ground contact periods.  

 
Figure 3.2.2:  The 
Report Files 
Window 

  

Note:  Clicking on any of the Select… buttons opens the lower pane that allows files to be 
selected.  
  

Note:  When reports are automatically downloaded from MMS, the fields in the Report 
Files window are pre-populated with the local location of the files that were 
downloaded. 
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Figure 3.2.3:  The 
Report Files 
Window 
showing the 
lower pane for 
selecting files 

  

Note:  Clicking the Add File… buttons causes a standard file browser to be displayed. 
Through the file browser, one can visually locate report files. The Remove File 
button allows removal of the selected file 
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3.3 Layout of the Timeline 
 

Overview 
The timeline displayed in the main window contains a wealth of information 
regarding the playback schedule events. This section describes the layout of the data 
on the timeline and description of the available fields. Note that descriptions of field 
contents will be delayed to later sections. 
  

 Each event on the timeline contains the following fields: Note that some fields 
are not valid or used for some event types. 

Add button This button is only valid (has a label and is active) for K 
or X band contact periods. This button allows the 
operator to add a new dump window to the contact 
period. 

Edit Button This button is valid (present) only for dump windows. 
This button allows the operator to modify or remove an 
existing dump window. 

View Button This button allows the operator to enter a comment for 
the event.  

DOY This field contains the integer day of the year for the 
event. 

Time This field contains the time of the event.  

Dur/Int This field has different meanings depending on the 
event type. For contact periods, this field contains the 
duration of the contact. For playback start events this 
field contains the difference between the start of this 
playback and previous playback and for playback stop 
events, this field contains the safety margin or difference 
between the actual playback end and the end of the 
corresponding dump window. 

Station/Arg This field contains station name or argument data 
depending on the event type. For TDRS contacts, this 
field contains the 3-character name of the contact. For 
playback start events, this field contains the PBLEX 
argument (playback duration) if the playback is a FLEX 
playback, or the maximum dump percentages for the 
MODIS, MISR, and ASTER buffers separated by 
commas for non-flex playbacks. 

Event This field contains the type of the event. 

MOD% This field is only valid for synchronization point events, 
playback start events, and playback carryover events. 
The field contains the MODIS buffer usage in percent. 

MIS% This field is only valid for synchronization point events, 
playback start events, and playback carryover events. 
The field contains the MISR buffer usage in percent. 
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AST% This field is only valid for synchronization point events, 
playback start events, and playback carryover events. 
The field contains the ASTER buffer usage in percent. 

MOD This field is only valid for synchronization point events, 
playback start events, and playback carryover events. 
The field contains the time allocated to playing back 
data from the MODIS buffer. 

MIS This field is only valid for synchronization point events, 
playback start events, and playback carryover events. 
The field contains the time allocated to playing back 
data from the MISR buffer. 

AST This field is only valid for synchronization point events, 
playback start events, and playback carryover events. 
The field contains the time allocated to playing back 
data from the ASTER buffer. 

TOT This field is only valid for playback start events. The 
field contains the Total playback time allocated for all 
buffers. 

MOD_Lim This field is only valid for playback start events. The 
field contains a color-coded value if the MODIS buffer 
usage exceeds the user specified Red or Yellow Limit.  

MIS_Lim This field is only valid for playback start events. The 
field contains a color-coded value if the MISR buffer 
usage exceeds the user specified Red or Yellow Limit. 

AST_Lim This field is only valid for playback start events. The 
field contains a color-coded value if the ASTER buffer 
usage exceeds the user specified Red or Yellow Limit. 

Comments This field contains a user specified comment for the 
event. 



3. Working with Schedules 
 

 26

3.4 Creating Contacts 
 

Overview 
Creating contacts is the process of parsing the selected report files and extracting 
required events. Extracted events are then filtered and displayed on the timeline. 
During contact creation, ASSET also selects a synchronization point and places 
initial dump windows in contact periods. 
  

 To create contacts: 

 Pull down the File menu and select Create Contacts OR 

 Click on the Create Contacts icon on the toolbar.    

Figure 3.4.1 shows the main window and timeline after contact creation. 
 

Figure 3.4.1:  The 
ASSET timeline 
after creating 
contacts 

  

 Since contact lists cannot be created until the scheduling options have been 
specified, the Create Contacts operation is disabled until scheduling options 
have been specified. 
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3.5 Generating a Schedule 
  

Overview Generating a schedule is the final step in creating an SSR playback schedule. The 
end product of this step is an SSR playback schedule that can be saved (either as 
binary or as text) or printed. 
  

 To generate a playback schedule: 

Pull down the File menu and choose Generate SSR Playbacks OR 

Click on the Generate SSR Playbacks icon on the toolbar.   

Figure 3.5.1 shows a completed schedule. 
 

Figure 3.5.1:  The 
ASSET timeline 
after generating 
a playback 
schedule 

 

 

ASSET automatically creates synchronization points and dump windows during 
contact list creation. The user may change the selected synchronization point, 
add, edit or delete dump windows before generating the schedule. 

 

 

Use the Add and Edit buttons to work with dump windows prior to generating 
the schedule. See Section 5.2: Dump Windows 
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 To select a different synchronization point: 

Pull down the File menu and choose Synchronization Points… OR 

Click on the Synchronization Points icon on the toolbar.   

See Section 5.4: Synchronization Points for more information on synchronization 
points and their usage. 
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3.6 Saving Schedules 
  

Overview 
The currently active (visible) playback schedule can be saved in either binary or text 
format. Schedules saved as binary can be reloaded into ASSET and used as a 
starting point for creating new schedules while text files cannot be reloaded into 
ASSET. The save as text option is provided for archival purposes so that human 
readable versions of complete schedules can be maintained for later review. For text 
saves, the timeline data saved is not filtered in any way. All event types and fields 
are saved.  
 

 To save a schedule: 

Pull down the File menu and choose Save OR 

Click on the Save Schedule icon on the toolbar.    

Figure 3.6.1 shows the dialog presented to the operator for saving schedules.  
  

Figure 3.6.1:  The 
Save As dialog  

 To save a schedule in binary format: 

Select “Asset Schedules (*.asset)” is selected in the Files of Type: field 

To save a schedule in text format: 

Select “Text Schedules (*.txt)” is selected in the Files of Type: field 
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 If the user selects the name of an existing file, ASSET prompts the user to 
confirm that it is okay to overwrite the existing file. Selecting Yes causes the tool 
to overwrite the existing file. Selecting No allows the operator to specify another 
file name. 

For Binary saves, files are saved with a “.asset” extension. Text saves result in a 
file with a “.txt” extension. 

 
 

 The user can also use the Save As button to save a schedule with a different 
name. This is particularly useful when an existing schedule is reloaded and used 
as a baseline for a new schedule. 
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3.7 Opening Saved Schedules  

Overview 
Starting with version 3.0, ASSET now includes the functionality to open saved 
schedules. This means previously generated schedules can be saved, reloaded into 
ASSET and used as baselines for new schedules. However, only schedules saved in 
binary format can be reloaded into ASSET.  
 

 To open a saved schedule: 

Pull down the File menu and choose Open OR 

Click on the Open Schedule icon on the toolbar.    

Figure 3.7.1 shows the dialog presented to the operator for opening schedules.
  
  

Figure 3.7.1:  The 
Open Schedule 
dialog  

 
 

 

 Once a saved schedule has been opened, it can be used as the starting point for a 
new schedule. 
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3.8 Printing Schedules  
 

Overview The currently active (visible) schedule can be sent to a printer for printing. The user 
may choose to customize the fields and/or events that are included in printouts by 
using the print filters. See Section 4.3: Print Filters for information on how to use 
print filters to control the amount and type of data printed. 

  
  

 To print a schedule: 

Pull down the File menu and choose Print OR 

Click on the Print icon on the toolbar.   

 
  

 ASSET displays a dialog that allows the user to enter additional text to be 
included with the printed schedule.  

Click Print to immediately print the schedule without previewing it. 

Click Preview to view a print preview of the schedule before printing. The print 
preview display is shown in Figure 3.8.1. 

Click Cancel to cancel printing. 

Figure 3.8.1 shows the additional header text dialog. 
 

Figure 3.8.1: The 
dialog for 
entering 
additional text 
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Note: ASSET loads default text for the “Additional Header Text” field. By default the 
files is called “header.txt” and is located in the application directory. However, 
the user can change the default location by using the preferences dialog. See 
Section 5.1: Preferences for more information 

Figure 3.8.2: The 
print preview 
window 

 

Note: Depending on how the print filters have been set, the user may find that all the 
columns are not displayed. Either reduce the number of columns printed or use 
the Page Setup (under the File menu) to select a wider paper type (e.g. Legal). 
Be sure to verify that your printer can support the paper type you selected. 

Note: Print filters can be used to control the amount of data shown on the printed 
schedule (and print preview). See Section 4.3: Print Filters 
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4 Filtering Data 
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4.1 Filters 
 

Overview ASSET allows the user to filter the amount and types of data shown in both the 
timeline and printed schedules.  Simply put, filters are a way to limit the amount of 
data shown on the timeline and/or in printed schedules. ASSET allows filtering by 
event type (i.e. row filtering) and fields (i.e. column filtering). Display filters affect 
the information shown on the timeline while print filters affect information included 
in printed schedules.  

There are two types of filters: event filters and field filters. Event filters allow the 
user to select which event types to display on the timeline or to include in the printed 
schedule. Field filters on the other hand affect the fields shown for each event. In 
essence event filters filter row-wise while field filters filter column-wise. 
  

Note: While field filters are fixed in number and never change, event filters vary based 
on the types of report files used to generate the schedule. As such the user will 
not be able to configure event filters until reports have been parsed. In addition 
changes to event filters are not persistent across multiple invocations of ASSET. 
However, changes to field filters are persistent. 
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4.2 Display Filters 

Overview Display filters allow the user to customize the amounts and types of data shown on 
the timeline.  The display filter contains both event and field filters. You can edit 
either type of filter from the display filter window. 
  

 To edit the display filters: 

Pull down the Settings menu, choose Filters and then choose Display 
Filters OR 

Use the CTRL+SHIFT+D keyboard shortcut. 

The display filters windows are shown in Figures 4.1.1 and 4.1.2. 
 

Figure 4.1.1:  The 
display filters 
window 
showing fields 
filter 
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Figure 4.1.2:  The 
display filters 
window 
showing event 
filter 

 
 

 To make a field or event type visible: 

1.  Select the field or event type from the left list (Available). 

2.  Click the Show button to move it to the right list (Visible). 

 

 To make a field or event type invisible: 

1.  Select the field or event type from the right list (Visible). 

2.  Click the Hide button to move it to the left list (Available). 

 

Note: The ordering of fields on the timeline is user customizable. The order in which 
the fields are displayed in the filter box determines the order of the fields on the 
timeline. 
 

 To change the order of fields on the timeline: 

1.  Select the field or a group of contiguous fields from the right list 
(Visible). 
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2.  Click the Up button to move the selection up in the list and causes the 
fields to be moved to the left on the timeline. Selecting the Down 
button to moves the selection down in the list and right on the timeline.

 

Note: The user may also select multiple contiguous fields before clicking the Show, 
Hide, Up or Down buttons. 

 
 

 The user may also access the display filter by clicking the right mouse on the 
timeline column headers. This displays a list of checkboxes, each representing a 
column in the timeline. 

1.  Uncheck a column’s checkbox to make the column invisible. 

2.  Check a column’s checkbox to make the column visible. 

 

 In addition, the user can re-arrange the column settings by dragging columns 
from one position to the other. 
 

Figure 4.1.3:  The 
timeline 
showing the 
right-click menu 
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4.3 Print Filters 
 

Overview Print filters allow the user to customize the amounts and types of data shown in the 
printed schedule.  The print filter contains both event and field filters. The user edits 
both filters within the same window. 
  

 To edit the print filters: 

Pull down the Settings menu, choose Filters and then choose Print 
Filters OR 

Use the CTRL+SHIFT+P keyboard shortcut. 

The display filter windows are shown in Figures 4.3.1 and 4.3.1. 
 

Figure 4.3.1:  The 
print filters 
window 
showing fields 
filter 
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Figure 4.3.2:  The 
print filters 
window 
showing event 
filter 

 
 

 To make a field or event type visible: 

1.  Select the field or event type from the left list (Available). 

2.  Click the Show button to move it to the right list (Visible), 

 

 To make a field or event type invisible: 

1.  Select the field or event type from the right list (Visible). 

2.  Click the Hide button to move it to the left list (Available). 

 

Note: The ordering of fields on the timeline is user customizable. The order in which 
the fields are displayed in the filter box determines the order of the fields on the 
timeline. 
 

 To change the order of fields on the timeline: 

3.  Select the field or a group of contiguous fields from the right list 
(Visible). 
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4.  Click the Up button to move the selection up in the list and causes the 
fields to be moved to the left on the timeline. Selecting the Down 
button to moves the selection down in the list and right on the timeline.

 

Note: The user may also select multiple contiguous fields before clicking the Show, 
Hide, Up or Down buttons. 
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5 Miscellaneous Information 
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5.1 Preferences  
 

Overview The ASSET preferences provide the user with a mechanism for customizing parts of 
the ASSET user interface through the preferences window.   Through the ASSET 
preferences, the user can customize the size of fonts used on the timeline, the colors 
used to represent each of the event types and more. 
 

 

To open the preferences window:  

Pull down the Settings menu and choose Preferences… OR 

Use the ALT+P keyboard shortcut. 

Figure 5.1.1 shows the ASSET preference dialog. 

  

Figure 5.1.1: The 
Preferences 
Window 

 

Note: The preferences window has three tabs. The first, titled “General”, contains 
settings that affect the general appearance of ASSET. The second, “Timeline”, 
provides access to settings that affect the display of data on the timeline. The 
third tab contains miscellaneous settings. 
 

 The General Tab contains the following options: 
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Look and Feel Use this drop down menu to choose a look and feel for 
ASSET. The Java Look and Feel (the default) gives 
ASSET the look and feel of a typical Java application. 
The Microsoft Windows Look and Feel makes ASSET 
appear like any other Windows applications. The 
CDE/Motif Look and Feel makes ASSET appear like a 
Common Desktop Environment (CDE) or UNIX 
application. 

Print Header File containing the default header used in printed 
reports. 

Reports Directory The default directory ASSET for report files. 

Data Directory The default directory for schedule saves. 

 

 The Timeline tab contains the following options: 

Auto Save Column 
Widths 

Check this box if you want ASSET to automatically 
save the widths of the columns on the timeline. See 
Section 5.9: Timeline Column Widths for more 
information about how this value is used. 

Font Size The font size used on the timeline display. Note that 
this setting only affects the data section of the 
timeline. The command buttons, for adding dump 
windows and comments, will remain the same size  

Color of X-band 
Contacts 

Color for displaying x-band contacts on the timeline. 

Color of S-band 
Contacts 

Color for displaying s-band contacts on the timeline. 

Color of K-Band 
Contacts 

Color for displaying k-band contacts on the timeline. 

Color of Dump 
Windows 

Color for displaying dump windows on the timeline. 

Color of Playback 
Windows 

Color for displaying playback windows on the timeline. 

Color of Rate Change 
Events 

Color for displaying rate change events on the 
timeline. 

 

 The Miscellaneous tab contains the following options: 

Show Advanced Edits Check this option to instruct ASSET to automatically 
display the modeling parameters window in Advanced 
Mode. See Section 5.5: Modeling Parameters 

Number of Recent 
Schedules 

This value controls the number of schedules ASSET 
remembers on the “Recent Schedules” menu.  

Note: The user can reset the settings to the default values by clicking on the Reset 
button. 
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5.2 Dump Windows 
 

Overview Dump windows are intervals within a contact during which the data in the SSR 
buffers may be played back.  ASSET automatically creates and adds dump windows 
to X and K band contact periods during contact list creation. ASSET also allows the 
user to add additional dump windows, edit, or delete existing dump windows using 
the dump window editor.  
  

 

To add a new dump window: 

Click the Add button next to the corresponding K or X band contact. Figure 5.2.1 
shows an empty dump window editor. 

To view or edit an existing dump window: 
Click the Edit button next to the dump window. Figure 5.2.2 shows the dump 
window editor with dump window settings loaded. 
  

Figure 5.2.1: The 
dump window 
editor opened 
for adding a 
new dump 
window 

  

Figure 5.2.2: The 
dump window 
editor opened 
for editing an 
existing dump 
window 

  

 From the dump window editor: 

1.  Click the Save button to save. 

2.  Click the Delete button (if available) to delete the dump window. 

3.  Click the Cancel button to cancel changes. 
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Note: Partial Playbacks 

Under certain special circumstances, ASSET can automatically insert an 
additional playback into a FLEX dump window.  The additional playback replays 
a percentage of the first buffer in the FLEX priority scheme and is inserted 
before the FLEX playback to prevent the lockup/replay portion of the first data 
buffer from being overwritten during a playback. ASSET automatically identifies 
the conditions of a partial playback and inserts an additional playback when the 
buffer usage of the first buffer in the FLEX priority scheme plus the amount of 
data recorded in that buffer during the FLEX playback exceeds a specific 
threshold.   

The user may disable/enable automated creation of partial playbacks for an 
entire schedule by selecting or unselecting the "Create Partial Playbacks" option 
in the Scheduling Options dialog. Additionally, ASSET allows the operator to 
select partial playback scheduling for individual dump windows by using the 
Create Partial Playback field shown in the Figure 5.2.1 and 5.2.2 above. 

As of release 3.0 of ASSET, the threshold values for each of the ASSET buffers 
that trigger partial playbacks and the amount of data dumped in a partial 
playback are not user configurable. 
 

Note: Changing the values of a dump window invalidates associated playbacks in the 
dump window and causes them to be removed. 

Also adding, editing or deleting a dump window will cause the playback schedule 
to be re-generated 
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5.3 Dump Windows Offsets 
 

Overview During contact creation ASSET determines an initial set of dump windows for the 
available contact periods. These dump windows are offset in the schedule from their 
corresponding contact's start and stop times by a series of user configurable offsets. 
This dialog provides the user access to the value of those offsets. There are 5 offsets 
for a given contact with each having a different configurable value. Three of these 
offsets are specific to K and S band contacts and the other two are specific to X band 
contacts.  
  

 

To edit dump windows offsets: 

Pull down the Settings menu and choose Dump Windows Offsets… OR 

Use the ALT+D keyboard shortcut. 

  

Figure 5.3.1: The 
dump windows 
offset dialog  

 

 The Dump Windows Offsets dialog contains the following fields: 

For K and S-Band contacts, there are three relevant values used depending on 
the time difference between the start of an S-Band contact and it's corresponding 
K-Band contact. If the distance is less than a specified threshold, the first AOS 
Dump Start offset is used. Otherwise the second AOS Dump Start offset value is 
used. 

Threshold For AOS Events The threshold value used to determine which 
offset to use for AOS dump start (for K and S-Band 
contacts). The default value is 60 seconds 

AOS Dump Start Offset 
(Delta < Threshold) 

This is the offset between a dump window's start 
time and the start time for its contact 
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AOS Dump Start Offset 
(Delta >= Threshold) 

This is the offset between a dump window's start 
time and the start time for its contact 

LOS Dump Stop Offset This is the offset between a dump window' stop 
time and the stop time for its contact 

AOS Dump Start Offset This is the offset between a dump window's start 
time and the start time for its contact 

LOS Dump Stop Offset This is the offset between a dump window' stop 
time and the stop time for its contact 

 

 To edit the dump windows offset:  

1.  Update one or more of the offset values. 

2.  Click the Save button to save changes or Cancel to discard changes. 
The Reset button restores the offset settings back to defaults. 

 

Note: Dump windows offsets only affect how ASSET automatically creates dump 
windows. Manually created dump windows do not use these offsets. 
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5.4 Synchronization Points 
 

Overview 
A synchronization point is the latest contact before the start of the planning horizon 
long enough to completely empty the SSR buffers. A synchronization point is needed 
before a playback schedule can be generated. 

While creating contacts, ASSET generates a list of "candidate" synchronization 
points and selects one of the candidates as the default synchronization point for 
scheduling. ASSET allows the user to select a different synchronization point using 
the Synchronization Point window. 

If an SSR buffer states report is not specified in the scheduling options, no candidate 
synchronization point is created. In addition, dump windows are not automatically 
created. 
  

 

To open the synchronization points window:  

Pull down the File menu and choose Synchronization Points… OR 

Click on the Synchronization Points icon on the toolbar.   

Figure 5.4.1 shows the synchronization point selection window. 

 

Figure 5.4.1: The 
Synchronization 
Points Window 

 

 To select a different synchronization point:  

1.  Click the radio button to the left of the desired synchronization point. 

2.  Click the Save button to save the new selection. 

 

 To select a manual synchronization point:  

1.  Click the Set Manual button 

2.  ASSET will display a dialog where the user can enter the start 
date/time of the manual synchronization point. The date/time entered 
must be within a contact period. 
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3.  After the user enters a valid start date/time, ASSET creates a 
manual synchronization point and adds it to the list of 
synchronization points. The newly added manual synchronization 
point is automatically selected and replaces any existing manual 
synchronization point. 

 

 

Note: Selecting a new synchronization point causes ASSET to move the 
synchronization point in the timeline, re-compute dump windows and re-
generate the playback schedule. Dump windows that are invalid (i.e. are before 
the newly selected synchronization point) are deleted. In addition, selection of a 
new synchronization point invalidates and deletes all existing playbacks. 

Prior to moving the synchronization point, ASSET prompts the user to confirm 
the new synchronization point. The prompt is shown in Figure 5.4.2. 
 

Figure 5.4.2: 
ASSET prompt 

 



 Index 
 

 52

5.5 Modeling Parameters 
 

Overview The modeling parameters are configurable parameters and represent values such as 
buffer capacities and rates used to compute playback durations and buffer usage 
values during schedule generation. The values include capacities of the MODIS, 
MISR and ASTER buffers, conversion rates between bits and Supersets, imaging 
rates, buffer playback rates, playback priorities etc.  
  

 

To open the modeling parameters window:  

Pull down the Settings menu and choose Modeling Parameters… OR 

Use the ALT+M keyboard shortcut. 

The modeling parameters window is shown in Figures 5.5.1 and 5.5.2. 

 

Figure 5.5.1: The 
Modeling 
Parameters 
Window, 
without 
advanced edits 

 

Figure 5.5.2: The 
Modeling 
Parameters 
Window, with 
advanced edits 
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Note: The user may switch between advanced and regular mode by clicking the 
Show/Hide Advanced button. 

Also note that the user can customize ASSET so that the tool always shows the 
modeling parameters window in advanced mode through the Preferences 
window. See Section 5.1: Preferences 
 

 For MODIS and MISR, the dialog allows the user to set the following:  

• Buffer Capacity in supersets.  

• Day Imaging Rate in bits per second.  

• Night Imaging Rate in bits per second.  

• Day Offset in MM:SS format.  

• Night Offset in MM:SS format.  

For ASTER, the user can set:  

• Buffer Capacity in supersets.  

• Auto Imaging Rates: Use this button to open the ASTER Rates editor. 
See Section 5.6: ASTER RTCS Identifiers. 

This dialog also lets the user edit the following playback rates:  

• Ground Contact Rate (Bps).  

• Playback Offset (MM:SS.  

• Bits/Superset.  

Dump Time Allocation Priority: This allows the user to modify the PBFLEX 
dump time allocation priority. Use the Up and Down buttons to move buffers up 
and down in priority.  

ASTER Instruments Imaging Rates:  

• TIR Imaging Rate in bits per second.  

• SWIR Imaging Rate in bits per second.  

• VNIR1 Imaging Rate in bits per second.  

• VNIR2 Imaging Rate in bits per second.  
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5.6 ASTER RTCS Identifiers 
 

Overview ASTER RTCS identifiers are used to model the behavior of the RTCS macros in 
Mission Management Software (MMS). The ASTER instrument is really a series of 
four instruments operating in different configurations to provide a series of modes of 
operation. ASTER RTCS macros define individual modes of operation for the ASTER 
instrument. ASTER is composed of the following instruments: Short-wave Infrared 
(SWIR), Thermal Infrared (TIR) and two Very Near Infrared instruments (VNIR1 
and VNIR2). Each ASTER RTCS is a macro and contains a description of the 
instruments used, and when they turn on/off relative to the command time. ASSET’s 
default settings include RTCS macro definitions for the most commonly used ASTER 
RTCS macros. Macros can be added, edited or deleted via the ASTER Rates window.  
 

 

To open the ASTER Rates window:  

Pull down the Settings menu and choose ASTER Rates… OR 

Use the ALT+A keyboard shortcut. 

The ASTER Rates window is shown in Figure 5.6.1. 

 

Figure 5.6.1:The 
ASTER Rates 
window 
showing default 
RTCS macros 

 

Note: In order to combine adding and editing RTCS macros functionality, the ASTER 
Rates window operates in two modes: 

• Add mode for adding new RTCS macros. 

• Edit mode for editing/deleting existing RTCS macros. 

Depending on the mode the window is in some buttons may be unavailable. 

 

 To add a new RTCS macro:  

1.  Fill in all the required information about the new macro. All fields 
are required (some fields have default values already filled in). 
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2.  Click the Save button to save the new macro. 

3.  ASSET will display an error if a required field isn’t entered. See 

Figure 5.6.2. 

 

 To edit/delete an existing RTCS macro:  

1.  Double click the RTCS macro (in the display table). 

2.  ASSET will display the macro’s information in the edit fields. 

3.  Make your changes to the macro. 

4.  Click the Save button to save or the Delete button to delete the 
macro. 

5.  ASSET displays an error if a required field isn’t entered. 

 

Figure 5.6.2: 
ASSET prompt 
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5.7 Red and Yellow Limits 
 

Overview During buffer playback planning, it is necessary to track buffer usage and notify the 
operator when buffer usages meet or exceed thresholds. The Red and Yellow limit 
settings in the ASSET tool provide this functionality. They allow ASSET to color 
code buffer usage columns in playbacks when user specified buffer thresholds are 
met or exceeded. By color-coding the playback entries this way, the operator can 
visually determine which playbacks exceed the specified thresholds and adjust other 
dump windows to prevent buffer overrun.  

In addition to limit settings for buffer, ASSET provides a way to enter red and yellow 
limits for playback delta and playback safety margins. Playback delta is the interval 
between two consecutive playback start events. Playback safety margin is the 
interval between a playback stop event and its enclosing contact stop event. 

 
 

 

To open the Red and Yellow Limits window:  

Pull down the Settings menu and choose Red & Yellow Limits… OR 

Use the ALT+L keyboard shortcut. 

Figure 5.7.1 shows the Red & Yellow limits dialog. 

 

Figure 5.7.1:The 
Red & Yellow 
Limits window  

 

 To edit Red and Yellow limits:  

1.  Update one or more of the limit values. 

2.  Click the Save button to save changes or Cancel to discard changes. 
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5.8 Station Management 
 

Overview As of version 3.0, ASSET now provides the user with a way to specify which TDRS 
stations and Ground contacts are available for playback. This feature allows the user 
to add, edit and delete TDRS stations and ground contacts. In addition, a station or 
contact may be designated as not available for playback. 

 
 

 

To open the Station Management window:  

Pull down the Settings menu and choose Station Management… OR 

Use the ALT+G keyboard shortcut. 

Figure 5.8.1 shows the Station Management dialog. 

 

Figure 5.8.1:The 
Station 
Management 
Window  

 To add a new station or contact:  

1.  Enter the name of the station/contact 

2.  Choose whether the new entry is a TDRS Station or a Ground 
Contact 

3.  Check whether entry is available for playback 

4.  Click the Add button to save changes or Cancel to discard changes. 

 

 To edit or delete an existing station or contact:  
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1.  Double click the entry to edit 

2.  Make changes to the entry 

3.  Click the Save button to save changes or Cancel to discard changes. 
You may also click the Delete button to delete the entry. 



 Index 
 

 59

5.9 Timeline Column Widths 
 

Overview ASSET allows the user to customize the widths of the columns on the timeline. The 
user does this by dragging the boundaries of the column header. By default, ASSET 
saves any change to the column widths. However, the user can choose to turn off 
automatic saving of timeline column widths by going through the Preferences dialog. 
See Section 5.1: Preferences for more information. 
 

 

To change the width of a timeline column:  

Use the mouse to drag the column header. 

 

Figure 5.9.1 shows the width of the Time column being changed. 

 

Figure 5.9.1: 
Changing 
column width  

 

 To manually save the column widths:  

1.  Pull down the Settings menu, choose Columns sub-menu and then 
choose Save Timeline Column Widths 
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5.10 Print Column Widths 

Overview ASSET allows the user to customize the widths of the columns on the printed 
schedule. This feature lets the user specify how wide each field on the printed report 
will be. 
 

 

To open the Print Column Widths window:  

Pull down the Settings menu, choose Columns and then choose Set 
Print Column Widths… OR 

Use the ALT+W keyboard shortcut. 

Figure 5.10.1 shows the Print Column Widths dialog. 

 

 

Figure 5.10.1: 
Print Column 
Widths 

 

 Click the Reset button to reset column widths to their default values. 

 Click the Preview button to see a preview of the schedule using the new column 
widths. This button is available only if there is a schedule current open in 
ASSET. 

 Click the Cancel button at any time will roll back any changes made to the 
column widths (even if a preview has already been generated). 
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5.11 MMS Interface 

Overview With the release of version 4.0 of ASSET, report files can now be automatically    
retrieved from the Mission Management Software using the MMS interface. This 
process involves requesting report generation from the MMS system, waiting while 
the MMS system processes the request and finally, downloading the generated 
report files to the user's local computer.  

ASSET utilizes 5 different types of report files to generate a schedule. Three of these 
report types (TDRS Contacts, SSR buffer states and WOTIS contacts) can be 
requested from MMS and are referred as "MMS Products". The Orbital events report 
is not requested from MMS but can be retrieved from a separate   directory on the 
file server and is referred to as an "FDS Product". The last report type, the ATC Load 
report, is not normally available when initially planning SSR dumps and thus must 
be manually retrieved by the user and placed on the local computer if needed.  
 

 

In order to download files from the MMS system, the information needed to 
connect to the remote servers must be set. This can be done using the MMS 
Interface window. 

To open the MMS Interface window:  

Pull down the Settings menu, Click MMS Interface… OR 

Use the ALT+I keyboard shortcut. 

Figure 5.11.1 shows the MMS Interface dialog. 

 

 

Figure 5.11.1: 
MMS Interface 
dialog 
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Figure 5.11.1: 
Progress dialogs 
showing various 
status of report 
download 

  

 The MMS Interface window contains 2 sections. The first section contains settings 
specific to the MMS server connection. The second section contains settings specific 
to the file server from which the required reports will be retrieved. Note that all 
remote connections whether to the MMS system or the file server occur through 
secure shell (ssh). 

IP Address This is the IP address or hostname of the MMS 
workstation 

Username The username used to connect to the IP address or 
hostname listed above 

Password Password associated with the username specified. For 
security reasons, the password is not as revealed as it’s 
being typed. 

Request Directory Remote directory in which to put the MMS request file. 

 

IP Address This is the IP address or hostname of the File Server 
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Username The username used to connect to the IP address or 
hostname listed above 

Password Password associated with the username specified. For 
security reasons, the password is not as revealed as it’s 
being typed. 

Request Timeout The maximum time, in minutes, to spend on each 
request to the File Server. 

Directory for MMS 
Products 

The directory on the file server where the MMS system 
will output the requested reports.  

Directory for FDS 
Products 

The directory on the file server where ASSET expects to 
find FDS products (i.e. orbital events report files). 

 

 Click the Reset button to reset fields back to their default values. 
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